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Note on Referencing PDF versions of Journals: 
 

PDF versions of print journal ar�cles are exact copies of the print edi�on and 

can, therefore, be referenced as print journals. 

In EndNote, there are reference op�ons available for ‘Journal Ar�cle’ and 

‘Electronic Ar�cle.’  When you export references into EndNote from the       

electronic databases, they will display as journal ar�cles.  This means that when 

you format them using GMIT’s Harvard style they will not display a URL for the 

ar�cle, even though you accessed them online and there is a URL in the End-

Note record.  These references are not incorrect. Most ar�cles available in the 

electronic databases are PDF versions of the printed journal and are therefore 

an exact copy of the print version which allows you to reference them as print 

ar�cles without including the URL. 

There are a small number of journals that are only made available                 

electronically; these need to be entered into EndNote as an ‘electronic ar�cle’ 

which will display the URL and Access Date fields.  These journals will typically 

be displayed in html format and will not have PDF versions available. 

 

For more informa�on or training on  

EndNote Online, please contact: 

libraryeservices@gmit.ie 

Kathryn: 091-742789 

Shirley:  091-742794 

Helen: 091-742791 
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What Happens When I Leave GMIT? 
 

Your references will be s�ll available in the EndNote Online account without 

the enhanced benefits of being linked to GMIT’s Web of Science subscrip�on. If 

you wish to save your references to another resource, such as Mendeley or 

Zotero, you can save your references as a text file on your own computer and 

import them in to the resource.   

To do this: 

1. Click the ‘Format’ tab and then ‘Export References’ 

2. Under the ‘References’ drop-down menu, select ‘RefMan (RIS) Export’.   

3. Click ‘Save’ and choose where you want to save the file. Your references 

are now saved as a text file.   

You can now import these into a free bibliographic management tool such as 

Zotero (Mozilla Firefox only).   

To import your saved references: 

1. Download Zotero and create an account (www.zotero.org) 

2. Click the   icon at the boHom right of your screen 

3. Click the gear wheel icon        and choose ‘Import’ 

4. Select the file where you saved your references as a text file 

5. Click ‘Open’ 

6. Press the sync icon                       and log into the Zotero server with your Zotero 

account details.  (If a window pops up, click ‘open sync preferences’) 

7. Click the sync icon again 

8. Your references are now in Zotero 
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Reac+va+ng Your EndNote Online Account 

Your EndNote Online account must be reac�vated every year you are a 

student/staff member at GMIT to con�nue geFng enhanced benefits.   

Note: You Must Reac+vate Your Account on Campus. 

1. Go to the ‘Web of Science’ database. 

(Click Databases on the Library Webpage to find a the list of databases in the  

library, choose Web of Science) 

 

2. Log in with your library account  details (Name, ID number & PIN) 

3. Click  the                           tab on the top menu bar                                                                         

4. Log in with your EndNote Online account details (email address & password) 

5. Your account is now reac�vated 
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Quick Guide to Collec+ng References 
 

Direct Export via Mul+Search 

This method may be used for most databases available through the 

GMIT Library website.  With databases that do not facilitate the direct 

export op�on (listed below) you must use the Import, Capture or Search 

within EndNote Online op�on. 

 

Import (Save as Text File) 

Dic�onary of Irish Biography 

 

 

Capture  

DOAJ 

Index to Theses 

Info4Educa�on 

Irish Times Online 

Irish Statute Book  

OCEDilibrary 

 

Online Search  (within EndNote Online) 

Library Catalogues 

PubMed 

Click ‘Help’ from www.myendnoteweb.com                                

to access help pages and video tutorials 
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What is EndNote Online? 

EndNote Online is a web applica�on that allows users to store and       

manage all their references in the one place.  

EndNote Online enables you to: 

• Create, store and manage references 

• Add references manually or export directly from online databases or 

library catalogues 

• Download references onto your computer to import into  EndNote  

• Store files up to 2 GB 

• Use the ‘Cite While You Write’ feature to insert references from your 

EndNote library into a Word document 

• Automa�cally create and format bibliographies in MicrosoN Word. 

Create an Account 

1. Go to www.myendnoteweb.com  

2. Click ‘Sign Up’ to register 

3. Complete all fields with an asterisk *. Click ‘I Agree’ 

 

Passwords must adhere to strict guidelines  

Must be 8 characters (no spaces) and contain: 

• At least 1 number 0-9 

• At least 1 alpha character (case sensi�ve) 

• At least 1 symbol: ! £ ? + % &                  Example: Study*10* 

 

An EndNote Online account is free on the web, but addi+onal bibliographic 

styles and databases will be available if you create your account in GMIT.  

Once you have created your account on campus, you can access your account 

from any computer with Internet access. 
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EndNote add-in and the EndNote tools will no longer be visible on the 

toolbar.   

To restore the EndNote tab: 

1. Open Word 2007  

2. Click on ‘File’ and ‘Op�ons’ 

3. When the Word Op�ons window opens, click on ‘Add-Ins’ in the leN-

hand column 

4. In the ‘Manage’ menu at the boHom of the page, select ‘Disabled 

Items’ and click on the Go’ buHon 

5. The EndNote add-in will show up as Add-in: cite while you write 

(endnote cwyw.dll) 

6. Highlight the EndNote add-in and select ‘Enable’ 

7. Close the Disabled Items window 

8. Click ‘OK’ at the boHom of the Word Op�ons window 

9. Close and re-open Word 

10. EndNote tab should now be visible 

 

EndNote Toolbar Not Visible in Browser 
 

If the EndNote and Capture buHon do not appear aNer downloading the 

installers: 

1. Click ‘View’ on the main menu at the top of the screen  

2. Click ‘Toolbars’ to see if a �ck appears beside EndNote Web. 

3. If not, select ‘EndNote Web’ to ac�vate the toolbar 

 

The EndNote Web buHon and the Capture buHon now appear on your 

screen under the Menu Bar. 
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•  Select the ‘Convert Cita+ons and Bibliography’ from the EndNote Online 

menu in Word    

• Click on ‘Convert to Plain Text’.  This will create a copy of your thesis 

which is no longer linked to EndNote Online 

Save this copy as thesis-final.doc. This is the copy which you should submit. 

This is not your master copy - any changes must be made to thesis-

master.doc. 

Note: If you need to make changes to your thesis, make them in thesis-

master.doc and then use the ‘Remove Field Codes’ command to make a new 

copy of thesis-unlinked.doc. 

 

Create a Stand Alone Bibliography 
 

You can create a formaHed stand alone bibliography with your references 

in EndNote Online.  

1. Select the ‘Format’ tab in EndNote 

2. Click on  ‘Bibliography’ 

3. Choose the references, bibliographic style, and file format. 

 If you want to export the bibliography to Word,  select the RTF file 

 format 

4. Select an op�on to save, email or print the bibliography  

 

EndNote Toolbar Not Visible in Word  

If Word 2007 has crashed while using EndNote, it will disable the EndNote 

Add-in and the EndNote tools will no longer be visible on the toolbar.  Also, 

if Word 2007 detects an error in the add-in, the EndNote tools will not be 

visible. If this occurs,  users will be presented with an error message.  If a 

user selects ‘Yes’ aNer the error message, then Word 2007 will disable the 
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Install Toolbars (Essen+al)  
 

To use EndNote Online off campus, you need to download the installers 

from the EndNote Online website. This is essen�al for EndNote Online to 

work on your PC or laptop. 

 

1. Click the ’Downloads’ link on the menu bar across the top of the page.        

2. Click on ‘Download Windows’ on the leN.  

3. Follow the on screen instruc�ons to complete installa�on (this will 

take 1-2 minutes). 

 

 

 

 

 

 

If you use Firefox as your Internet browser, you also need to install the 

Firefox extension on the right of the page. 

 

ANer you have downloaded the installers, you will see these icons on your 

browser toolbar:          IE: 

Firefox:  

 

You will also have the ‘Cite While You Write’ func�ons in MicrosoN Word 

(an extra tab will be present  for EndNote)  

Cite While You Write (CWYW) allows you to insert cita�ons from your End-

Note Online references library directly into your assignment as you type in 

Word.  
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Collect References - 5 op+ons 
 

1. Manually Add References 

Click ‘New Reference’ under the ‘Collect’ tab, select the reference type, enter the 

bibliographic informa�on into the appropriate fields. 

 

 

 

 

 

 

 

 

 

 

 

2. Direct Export of References via Mul+Search 

(GMIT Library Search Engine) 

Direct export works with results found via Mul2Search on the Library 

homepage. 

This is the fastest & easiest way to get references into your library. 
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• Open each document (chapter1-copy.doc, etc.) in Word 

• From the EndNote menu in Word, select ‘Convert Cita+ons and Bibliography’ 

• ‘Convert to Unforma=ed Cita+ons’.  This will remove the bibliography at 

the end of each chapter and change the references in the text into their            

unformaHed form, e.g. {Bloggs 2010 #9} 

• Click ‘Save’ 

 

3. Combine the Chapters 

• Open chapter1-copy.doc in Word 

• Open chapter2-copy.doc and select the whole document, copy it and paste it 

at the end of chapter1-copy.doc 

• Con�nue copying and pas�ng each chapter to the end of chapter1-copy.doc, 

un�l the whole thesis is in one document 

• Rename chapter1-copy.doc to thesis-master.doc. This is the master copy of 

your thesis, and any changes should be made to this  document 

•  Save this document 

 

4. Format Cita+ons in the Thesis 

• Open thesis-master.doc in Word 

• Click on ‘Update Cita+ons and Bibliography’ from the EndNote menu in Word. 

EndNote will format all the references in your document and create a single 

bibliography at the end of the thesis 

• Save the changes 

Note: Un-formaFng the cita�ons (as in Step 2 on page 24) disables the instant 

formaFng in Word. If you prefer to work with instant formaFng, go to the       

Bibliography Preferences by clicking on the small arrow at the right of the 

‘Bibliography’ group on the EndNote menu in Word, and then select the ‘Instant 

Forma@ng’ tab and click on the ‘Turn On’ buHon 

 

5. Remove Field Codes 

Your thesis-master.doc contains hidden field codes which link it to EndNote Online. 

The final step is to create a copy which is not linked to EndNote Online. 
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Combining Chapters to Create a Thesis 
 

If you have not wriHen your thesis as a single document (as recommended), 

you will need to combine the chapters to make one document with one  

complete list of references.  To  create the final thesis, you need to unformat 

the references in each document and combine the documents to create a 

master document. Please ensure you have no duplicate references in your 

EndNote library  before combining chapters (see page 12). 

1. Copy Each Chapter 

Make a copy of each chapter, e.g. chapter1-copy.doc; chapter2-copy.doc. 

You will work with these copies. If anything goes wrong, you can return to 

your original documents and start again. 

2. Unformat Cita+ons 

If you have been using EndNote instant formaFng, your references will     

already be formaHed, for example (Bloggs 2010), and you will have a         

bibliography at the end of each chapter. 

• Click on the reference to which you wish to add a file 

• Click  ‘AHach files’ 

• Browse your computer for the file you want and click ‘Upload’. 

• Close. Your file is now aHached. 

You can view what a5achments 

you have in your EndNote    

library at any 2me by clicking 

‘Organize’ and ‘Manage  

a5achments’. 
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1. Enter your search term(s) in the Mul�Search search tab (hHp://

library.gmit.ie) 

2. Add your search results to ‘Saved items folder’ 

 (click the icon on the right of each cita�on re-

quired) 

3. Click ‘Saved items’ at top of page 

4. Choose “EndNote” from ‘Export As’ drop down 

menu.  

5. When  Dialog  box  appears choose ‘Open’ (Internet Explorer) or ‘Open 

with:  ResearchSoN Direct Export Helper’ (Firefox) 

6. Enter your e-mail address and password for EndNote Online (if requested) 

7. References are exported to EndNote 
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3. Import (Save as a text file)  

Dic+onary of Irish Biography 

1. Select record 

2. Click ‘Ar�cle Services’ 

3. Click ‘Export RIS’ 

4. Select ‘Save’ and click ‘Ok’ 

5. Import file into EndNote (follow the instruc2ons below to import 

the text file of references into your EndNote Online Account) 

 

EndNote Filter: RefmanRIS 

 

 

 

 

 

 

 

 

 

 

 

  

 

How to Import a Saved Text File into EndNote Online 

1. In EndNote, click on ‘Collect’ 

2. Click on ‘Import References’ 

3. Under File: browse and select the saved file from your 

desktop or any other loca�on you saved it 

4. Under Filter: select the appropriate filter for the file 

(choose the filter that is listed under the database name 

in this guide). 

5. Click on ‘Import’ 

6. Click on the tab ‘My References’ 

7. Your references will appear in the ‘Unfiled’ folder 

(unless you choose a group before impor�ng) 
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Edit a Reference 

To edit a reference  in EndNote, find the reference you wish to edit in ‘All 

my references’.  Click on the �tle and the individual fields will display.  

Make the changes you require and click ‘Save’. 

 

Dele+ng References 
 

 

To Delete a Reference in Your EndNote Library 

Find the reference you wish to delete. Click on the box next to the �tle 

and click ‘Delete’.   

 

 

 

 

To Delete a Reference from a MicrosoD Word Document  

You should not do this by dele�ng the text of the reference within Word 

using the keyboard. Instead: 

1. Highlight the cita�on you wish to remove within 

your text 

2. From the toolbar click on ‘Edit Cita+on’ 

3. Click ‘Remove Cita+on’ from the dropdown menu  

4. Click ‘OK’ 

This removes the cita�on from your text and the reference at the end of 

your document. 

 

A=aching Files to your References 

EndNote Online allows you to store up to 2 GB of files to your references. 

For example, you may wish to store the PDF of the ar�cle with its           

reference. 
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Crea+ng Groups 
 

1. Click  ‘Organize’ then ‘Manage My Groups’ 

2. Click ‘New Group’ 

3. Name your group 

and click ‘OK’ 

 
 

 

Sharing a Group of References  

You can share groups of references with other EndNote Online users. 

1. Go to the ‘Organize’ tab and choose ‘Manage My Groups’ 

2. Click on the ‘Manage Sharing’ buHon 

3. Select ‘Start sharing this group’  

4. Enter the email address(es) of those  you wish to share with 

5. Click ‘Apply’ and close the window 

6. Check the box in the ‘Share’ column to ini�ate sharing 

7. The sharing icon will appear beside the group  

 

Pu@ng References in Groups 
 
When records are imported into EndNote, they are placed in the Unfiled 

group by default. To move references to a group: 

1. Click in the box to the leN of desired records; or Click on ‘All’ or ‘Page’ 

2. Select the desired group from the ‘Add to Group’ drop-down menu 

3. All selected records will be moved to the chosen group 
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4. Online Search  [Search from within EndNote Online] 

1. In EndNote Online: Click on  ‘Collect’ tab 

2. Click on ‘Online Search’ 

3. Select  database e.g. ‘PubMed’ and click Connect 

4. Perform your search 

5. Click Retrieve 

6. Tick the references you require 

7. Click the drop down menu above results ‘Add to group’ and select 

‘unfiled’ 

8. Results are now copied to your unfiled references 

 

5. Capture 

Use the capture buHon to take bibliographic informa�on from websites 

and databases listed on page 3.  Always check the data automa�cally  

entered and make any necessary amendments and/or addi�ons. 

 

Google Books  

1. Click on the �tle to display the available chapters (if preview only available) or to 

display the whole book (when full view available) 

2. Click ‘About this book’ on the top leN of the screen 

3. Scroll down to the boHom of the page 

4. Click the EndNote buHon 

5. When the dialog box appears choose ‘Open (Internet Explorer) or ‘Open with:  

ResearchSoN Direct Export Helper’ (Firefox) 

6. References exported to EndNote 
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Google Scholar 

Cita2ons have to be exported one at a 2me 

 

1. Click the seFngs buHon on the top of the screen  

2. Under ‘Bibliography Manager’ (at boHom of page), select RefMan 

3. Under ‘Library Links’ on the leN of the screen, add GMIT Library & click 

search 

4. Save preferences and conduct your search 

5. Click ‘Import into RefMan under the reference you want 

6. Log into your EndNote Online account if requested 

7. References exported to EndNote 

 

 

Scirus (Scien+fic Search Engine) 

1. Click  the checkbox on the leN of each result you want to export 

2. Click ‘Export checked results’ at top of screen  

3. Choose Export: ‘Cita�ons Only’ or ‘Cita�ons, keywords & abstracts’ 

4. Select the file  format : RIS format 

5. Choose ‘Save file to disk or open Reference SoNware’ & Export 

6. Click ‘Export’ 

7. If  Dialog  box  appears, choose ‘Open’ (Internet Explorer) or ‘Open 

with:  ResearchSoN Direct Export Helper’ (Firefox) & ‘Ok’ 

8. References exported to EndNote 
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Footnotes 

If you wish to use a Numbered cita�on style or footnotes in your           

document, you need to use the ‘References’ tab in MicrosoN Word. 

1. Put the cursor where you want to reference 

2. Choose ‘Insert Footnote’ (cursor moves to footnotes at the bo5om of 

the page) 

3. Go to ‘EndNote Web’ tab 

4.  Use the ‘Find Cita+ons’ buHon on the toolbar to search for the       

reference you want to insert 

5. Highlight the reference you want and click ‘Insert’ 

1. Insert the cita�on for the item you have read yourself (e.g. Ford) 

2. Click on the cita�on you have just inserted, so that it is highlighted, 

then click Edit Cita+on(s) 

3. In the Prefix field, 

type the date of the 

original work, plus 

the words as cited in. 

Press the spacebar 

aNer the word in. 

This will format the secondary cita�on and add the correct item to your 

bibliography. 

Ford, A. (1997) The Protestant Reforma2on in Ireland, 1590-1641. Dublin: Four 

Courts Press. 
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 In this case, you do not repeat the authors’ names in the cita�on in  

brackets. 
 

1. Type in whatever it is you wish to reference (i.e. Quick argues that this 

is the way ……) 

2. Insert your Cita�on in the normal way (i.e. puFng cursor aNer ‘Quick’ 

and then inser�ng cita�on) 

3. Highlight the Cita�on (e.g. Quick 2007) & click ‘Edit Cita+on’ on the 

EndNote Web toolbar 

4. Tick ‘Exclude Author’ and ‘Ok’ 

 

 

 

 

 

 

Note: if you wish to enter a reference in your bibliography that you have not 

cited in your text, insert as normal and then edit the cita�on by excluding the au-

thor and year. 

 

Secondary Cita+ons  

There are �mes that you will find something referenced in a book or an 

ar�cle that is so useful or interes�ng that you want to use it in your own 

wri�ng. This might be a cita�on for another ar�cle or book, or an           

illustra�on, graph or table taken from another work.  

 

In this case, your in-text cita2on should men2on both works, but your    

bibliography only includes a reference for the work you have actually read 

yourself 

 
Morley (1890, as cited in Ford, 1997) describes that people of that area are 

likely to receive any faith. 
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Using ‘Cite While You Write’  in MS Word 

Use the Cite While You Write (CWYW) plug-in to insert references and      

format cita�ons and bibliographies instantly while you write your essays in 

Word.  

Once the plug-in is downloaded (see page 6), a toolbar is added to Word to 

give easy access to the  features in EndNote.  

Remember you need to download the installers for each machine you use 

outside of the library. 

Click the ‘Download installers’ link at the boHom of the 

www.myendnoteweb.com page if you need to download the installers onto 

a new machine. 

 

How to Insert Cita+ons into Word Document 

1. In your Word document, place the cursor exactly where you want to  

insert the cita�on in the body of the text 

2. Use the                  buHon on the toolbar to search for the reference you want 

to insert 

3. Highlight the reference you want and click ‘Insert’ 

 

Change the Bibliographic Style 

1. In a Word document, click ‘Bibliography’ on the EndNote Web toolbar 

and choose  ‘Output style’ i.e. GMIT Harvard or GMIT HARVARD. 

 GMIT Harvard displays authors in lowercase i.e. Smith, J. in the reference list. 

 GMIT HARVARD displays authors in UPPERCASE i.e. SMITH, J. in the reference list. 

2. Choose ‘Layout’ tab and give your bibliography a �tle in the ‘Bibliography 

�tle’ box i.e. References.   

3. Click ‘OK’ 
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Removing Duplicate References  

Before inser�ng references into your assignment using MicrosoN Word, 

you must check that there are no duplicate references in your EndNote   

Library: 

1. Choose ‘Organize’, then ‘Find Duplicates’ 

2. If duplicates are present, they  are listed with the duplicate reference 

�cked 

3. Click ‘Delete’ to delete duplicates 

 

 

 

 

 

 

Adding Page Numbers to a Cita+on 

 

 

 

 

1. Highlight the reference to which you wish to add a page number 

2. Click on ‘Edit Cita+on’ from the EndNote Web toolbar 

3. In the ‘Suffix’ box, type in the appropriate page number (and     

punctua�on as shown below) and click ‘Ok’ 

Note: Do not use 

‘pages’ box 
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Corporate Authors  

The normal method of entering corporate authors is to put a comma at 

the end of the name when you enter it in your EndNote library. 

 

EndNote Online is alerted to the fact that this is the name of an                  

organisa�on, and not a person, and will now be able to format the         

reference correctly. 

However, when the corporate body contains one or more internal       

commas, you replace the first of those commas with two commas, and 

omit the comma at the end, e.g. Higher Educa�on Authority,, Interna�onal 

Assessment CommiHee. This should produce a properly formaHed         

bibliography.  

Note that this technique may create problems with the in-text cita�ons. If 

the output style is configured to insert the last name only in the in-text 

cita�on, the corporate author in the above example would appear in the 

in-text cita�on in the form (Higher Educa�on Authority 2010) instead of 

(Higher Educa�on Authority, Interna�onal Assessment CommiHee 2010). 

However, the entry in the bibliography at the end of the document should 

show the full name. In this case, you could ‘edit the cita+on’ in the text to 

‘exclude the author’, and then insert the correct form of the name as a 

‘prefix’ to the cita�on. 

 

Removing Author &/or Date from Cita+ons 

In your wri�ng, you will oNen integrate the author’s name into your      

sentence followed by the date and page numbers, if applicable, in      

brackets: 

 

 

e.g. Tourism Ireland,  

Ex:  Quick (2007) described the ….  


